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Watershed Delineation with ArcGIS 10.2.x 

 

Watersheds, also known as basins or catchments, are physically delineated by the area upstream from a 
specified outlet point. Watersheds can be delineated manually using paper maps, or digitally in a GIS 
environment. The process outlined in this document includes steps for delineating watersheds in ESRI’s ArcGIS 
Desktop 10.2.2 software. 
 
This guide assumes that you have obtained the required data, which includes a digital elevation model (DEM) 
and stream network file for your area of interest. Note that the Ontario Ministry of Natural Resources and 
Forestry (OMNRF) have released many of the data outputs that are created in this process as a packaged 
product known as Ontario Integrated Hydrology (OIH) data. Obtaining the OIH data set will allow users to skip 
many of the time-consuming and resource-intensive steps in the process, as noted throughout this guide. 
Should you have any questions regarding how to access the OIH or other government data sets, please contact 
us for assistance at madgichelp@trentu.ca 

 
Step 1 Set up your work environment 
 
Use the steps below to set up your map document and establish the working directory you will be using 
throughout the watershed delineation process. 
 

1. Open ArcMap and create a new, blank map document. Use the Add Data button  to add the DEM 
for your area of interest to the map. 
 

2. Browse to Geoprocessing > Environments. Under Workspace, set the variables for Current Workspace 
and Scratch Workspace to the directory where you wish to save your results. It is a good idea to create 
an empty file geodatabase for this purpose. Further information about the file geodatabase format can 
be found here. 
 
 

 
 
 
 
 
 

mailto:madgichelp@trentu.ca
http://www.esri.com/news/arcuser/0309/files/9reasons.pdf
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3. Browse to Environment Settings > Raster Analysis and use the drop down arrow to set the Cell Size 
property to be the same as the DEM layer. Click OK to accept the changes. 
 

 
 

4. If necessary, enable the Spatial Analyst extension (Customize > Extensions > Spatial Analyst).  
 

5. Open ArcToolbox from the main menu and expand the Spatial Analysis Tools > Hydrology toolbox to 
view its contents.  
 

 
 

6. Save your map document (File > Save). 

 

Step 2 Create a depressionless DEM 

Note: This step is not necessary when using OIH data from the OMNRF. 

 
The Fill tool in the Hydrology toolbox is used to remove any imperfections (sinks) in the digital 

elevation model. A sink is a cell that does not have an associated drainage value. Drainage values 

indicate the direction that water will flow out of the cell, and are assigned during the process of 

creating a flow direction grid for the landscape. The resulting drainage network depends on finding 

the ‘flow path’ of every cell in the grid, so it is important that the fill step is performed prior to 

creating a flow direction grid.  

 

Double click the Fill tool to open its dialog and enter the following parameters. 

 

1. Set the DEM grid as the Input surface raster. [screen shot] 

 

2. If necessary, set the Output surface raster to your working directory and provide a 

descriptive name for the output. 

 

3. Accept all other defaults and click OK to run the tool. This process can be resource-

intensive, and may take some time to complete depending on the processing power 

available to the software. 
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Note: The Show Help option at the bottom of the tool dialog provides help documentation for 

each parameter. In this case, the optional input of Z limit has been left blank; but it is important 

that you make your own decisions regarding optional parameters, as every analysis is different 

and dependent on the data that is being used. 

 

When the fill process is complete, a new grid will be added to the data frame of your map 

document. There should be a difference in the lowest elevation value between the original DEM 

and the filled DEM. 

 

You can now remove the original DEM layer from the map view (right-click > Remove) and save 

your map document. 
 
Step 3 Create a flow direction grid 
 
Note: This step is not necessary when using the OIH data from the OMNRF.  
 
A flow direction grid assigns a value to each cell to indicate the direction of flow – that is, the direction that 
water will flow from that particular cell based on the underlying topography of the landscape. This is a crucial 
step in hydrological modeling, as the direction of flow will determine the ultimate destination of the water 
flowing across the surface of the land. 
 
Flow direction grids are created using the Flow Direction tool. For every 3x3 cell neighbourhood, the grid 
processor finds the lowest neighbouring cell from the centre. Each number in the matrix below corresponds to 
a flow direction – that is, if the centre cell flows due north, its value will be 64; if it flows northeast, its value will 
be 128, etc. These numbers have no numeric meaning – they are simply codes that define a specific directional 
value, and are determined using the elevation values from the underlying DEM. 
 

 
 
         Flow direction matrix        Flow direction is north, cell is coded 64 
 
Double-click the Flow Direction tool to open the tool dialog and input the following parameters. 
 

1. Set the Input surface raster to the filled DEM created in the Step 2. 
 

2. If necessary, set the Output flow direction raster to your working directory and provide a descriptive 
name for the output file. 
 

3. Browse to Environment Settings > Raster Analysis and confirm that the Cell Size parameter is set to the 
same as your filled DEM. Click OK to run the tool. 
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This process may take quite some time to run through to completion. When the tool has finished, the new flow 
direction grid will be added to the map document. 
 
 

 
 
 
Step 4 Create a flow accumulation grid 
 
Note: This step is not necessary when using the OIH data from the OMNRF. 

 
The Flow Accumulation tool calculates the flow into each cell by identifying the upstream cells that flow into 
each downslope cell. In other words, each cell’s flow accumulation value is determined by the number of 
upstream cells flowing into it based on landscape topography. 
 
Double-click the Flow Accumulation tool to open the tool dialog and input the following parameters. 
 

1. Set the Input flow direction raster to the flow direction grid created in Step 3. 
 

2. If necessary, set the Output accumulation raster to your working directory and provide a descriptive 
name for the output. 
 

3. Browse to Environment Settings > Raster Analysis and confirm that the Cell Size parameter is set to the 
same as your filled DEM. Click OK to run the tool. 

 
The new flow accumulation raster will be added to your map document. Each cell in the grid contains a value 
that represents the number of cells upstream from that particular cell. Cells with higher flow accumulation 
values should be located in areas of lower elevation, such as valleys or drainage channels where water flows 
naturally while it is following the landscape. 
 
If the flow accumulation raster appears dark and the cell values are difficult to visualize then it will be necessary 
to alter the layer symbology. 
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Right-click the layer name in 
the table of contents and select 
Properties > Symbology. In the 
left pane, highlight Classified. 
Set the number of classes to 2 
and click Classify.  
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Set the first break value to a 
threshold number that will 
assist with delineating channels. 
This value will be based on your 
data, and is really up to the 
analyst. For this example we 
have used 5000 as a threshold, 
which means that cells that 
have less than 5000 upstream 
cells flowing into them will be 
symbolized differently than cells 
with more than 5000 upstream 
cells. Leave the second value as 
the maximum value in the grid. 
 
 
 
 
 
 

 
Click OK to return to the Symbology Properties dialog. Change the symbology by double-clicking the colour 
swatches under Symbol. Select No color for the first class (0-5000) and a bright red colour for the second class 
(5000+). Click OK to apply the changes and close the dialog. 
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The flow accumulation layer is now symbolized so that you are better able to visually pinpoint areas of high 
flow accumulation. As mentioned, the cells displayed in red have at least 5000 upstream cells flowing through 
them. Add your stream network layer to visually compare the flow accumulation data with the actual stream 
network. Note that the two data sets will not line up perfectly, but the flow accumulation grid should 
correspond closely with the watercourse data as shown below. 
 

 
 
Flow accumulations are important because they allow us to locate cells with high flow where streams and 
channels are to be expected. Each cell has an outlet point called a pour point that indicates the location where 
water would naturally flow out of the cell. Pour points must be located in cells with high cumulative flow or the 
delineated watersheds will cover very small areas. 
 
Step 5 Create outlet (pour) points 
 
Pour point placement is an important step in the process of watershed delineation. A pour point should exist 
within an area of high flow accumulation because it is used to calculate the total contributing water flow to that 
given point. In many cases you will already have a file containing the locations of your pour points, whether 
they are sampling sites, hydrometric stations, or another data source. However in some cases, it may be 
necessary or preferable to create pour points manually. Instructions have been provided for both cases below. 
 

a. Loading pour points from an existing file 
 
Add the point file containing pour point locations to your map document along with the flow 
accumulation grid created in Step 4. Zoom in to each point (or a random sample of points) to determine 
if they fall on a path of high flow accumulation. As mentioned, if the pour points are not situated in 
cells of high flow accumulation then the resulting watersheds will be excessively small. Assuming that 
your pour points are situated correctly, move on to Step 6.  
 

b. Creating pour points through visual inspection 
 

Open the ArcCatalog window  and create a new point file in your working directory (right-click the 
directory in the Catalog tree and select New > Feature Class if you are working from a geodatabase, or 
New > Shapefile if you are working from a folder). Give the file a descriptive name and apply the 
appropriate coordinate system for your data. Click OK to add the new point layer to the map document. 
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Zoom in to your study area so that you are able to see the individual cells of the flow accumulation grid.  

Use the Identify tool    to examine the values of the grid. The chosen pour point must be on the high 
flow accumulation path, and should be a natural outlet for the upstream cells. Your choice essentially 
determines the ‘end’ of your catchment area; everything upstream from the point that you create will 
define a single watershed. 
 
When you are satisfied with your choice, add the point by starting an editing session (Editor > Start 
Editing). If you are asked which layer you would like to edit, select the empty point layer and click OK.  
 

 
 

If necessary, open the Create Features window   and highlight the pour point file in the list. Move 
your cursor onto the map document and add a pour point by clicking in the centre of the cell you have 
chosen as the location of your outlet point. Try to place the points directly in the centre of the chosen 
cells and remember to place the points one or two cells away from stream confluences. 
 
If you are creating a single watershed then save your edits and move on to Step 6. 
 
If you are creating multiple watersheds, complete the process of adding outlet points then save your 
edits and exit the editing session. Open the point layer’s attribute table (right-click > Open Attribute 
Table), click the Table Options button and select Add Field. Create a field called UNIQUEID of type Short 
(short integer).  
 
Start another editing session and number your pour points sequentially (this can be done 
programmatically - see http://support.esri.com/fr/knowledgebase/techarticles/detail/38517).  
 
Save your edits and stop the editing session. Individual watersheds will be identified and delineated by 
the software using this UNIQUEID field. 

 
Step 6 Snapping pour points 
 
The Snap Pour Point tool accomplishes two things; it snaps the pour point/s created in Step 5 to the closest cell 
of high flow accumulation to account for any error during placement, and it converts the pour points to raster 
format for input to the Watershed tool. 
 
Double click the Snap Pour Point tool to open its dialog and enter the following parameters. 

 

1. Set the Input raster or feature pour point data to the pour point layer created or loaded in 

Step 5. 

 

2. Set the Pour Point Field to the UNIQUEID field created in Step 5 (only applicable when 

delineating multiple watersheds). 

 

3. Set the Input accumulation raster to your flow accumulation grid created in Step 4. 

 

4. Set the Output raster to your working directory and give the output a descriptive name. 

 

http://support.esri.com/fr/knowledgebase/techarticles/detail/38517
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5. The Snap Distance is the specified distance (in map units) that the tool will use to search 

around your pour points for the cell with the highest flow accumulation value. The snap 

distance should be based on the resolution of your data; it may require some trial and 

error to determine the best value. If your pour point is not located on a high flow pathway, 

the tool will move it to the cell within the search radius with the highest accumulation 

value. If your pour point is already located on the high flow pathway, then the tool will 

move the point to a downstream cell within the search radius. If it is important that your 

points remain at the exact cell location of initial placement, then run the tool with a snap 

distance of 0. 

 

6. Browse to Environment Settings > Raster Analysis Settings > Cell Size and ensure that the 

cell size is set to the same as your flow accumulation layer. 

 

Click OK to run the tool. The output will yield a raster file of pour points that will be added to the 

map document. 

 

Step 7 Delineate watersheds 

 

Double-click the Watershed tool to open the tool dialog and set the parameters as follows. 

 

1. The Input flow direction raster is the flow direction raster output in Step 3, or the 

enhanced flow direction grid provided with the OMNRF data package. 

 

2. The Input raster or feature pour point data is the raster pour point file created in Step 6. 

 

3. The Pour point field can be left as default, or optionally you may choose to select the 

UNIQUEID field created in Step 5. 

 

4. If necessary, set the Output raster to your working directory and provide a descriptive 

name for the output file. 

 

Click OK to run the tool. Upon completion, a new watershed raster will be added to your map 

document. 
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Step 8 Convert watershed rasters to polygons 
 
Most users will find vector watersheds more useful than raster files in order to run further geoprocessing and 
analyses. Raster files can be converted to vector format using the Raster to Polygon tool (ArcToolbox > 
Conversion > From Raster). Double-click the tool to open its dialog and enter the parameters as follows. 
 

1. Set the Input raster to the watershed raster file created in Step 7. 
 

2. If necessary, set the Output polygon features to your working directory and give the output a 
descriptive name. 

 
Leave all other defaults and click OK to run the tool. A new polygon file displaying your watersheds will be 
added to the map document. 
 
This completes the process of watershed delineation in ArcGIS 10.2.x. As mentioned, it is often no longer 
necessary to perform the majority of these steps if you have taken the steps to acquire hydrology data through 
MaDGIC. However if your study area falls outside the province of Ontario, or you wish to delineate watersheds 
independently for comparison purposes, then these steps can be used to guide you through the process. Please 
keep in mind that this guide is meant to be used as an example only; decisions should be made based upon the 
data you are using and the type of analysis you wish to perform. 
 
 
 
For further assistance with this guide or other topics related to geospatial and/or statistical data and 
software, please contact us at madgichelp@trentu.ca.  

mailto:madgichelp@trentu.ca

